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Vision and Mission

Mississippi Department of Education

2



Strategic Plan Goals

Mississippi Department of Education
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Session Norms

Mississippi Department of Education

Watch for info in the 

CHAT
Ask questions in the

Q&A
Stay engaged with

REACTIONS
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Mississippi Department of Education

Session Goals

RECAP
digital accessibility 
under ADA Title II

PERFORM 
manual and automated 
accessibility checks for 
slide decks

REVIEW
roles, responsibilities, 
and resources
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What is accessibility?
[Americans with Disabilities Act Title II]
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What is accessibility?

Who will benefit from these changes?

Title II requires that websites and mobile 
apps be accessible to individuals who use 
assistive technology, including people:
• Who are blind, color blind, or have low vision. 

• With learning disabilities such as dyslexia, 
dyscalculia, dysgraphia, or ADHD. 

• With head injuries or cognitive disabilities.

• Who are auditory learners.

• Who are aging.

Everyone using these technologies!
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What is accessibility?

Remove some of the many 
BARRIERS still faced by the 
disability community that 
make content inaccessible.
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Barriers to Digital Accessibility

Common Barriers to Digital Accessibility

1. Content headings

2. Table attributes or 
merged cells

3. Alt text for images

4. Reading order

5. Color Contrast

6. Text size and spacing

7. Transcripts and closed 
captioning

8. Flashes and animations

9. Hyperlink text and 
provide the purpose of 
the linked text
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Barriers to Digital Accessibility

Meaning cannot only 
be communicated 
visually. 
Images. Colors. Fonts.
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How can you ensure digital 
accessibility in your PowerPoints?
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Ensuring Accessibility

Use MDE Templates

MDE Word and PowerPoint 
Templates (2026) have built in 
styles that follow accessibility 
guidelines.

https://mdek12.org/communications/logos/
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Ensuring Accessibility

Ensuring compliance 
requires both manual
and automated
accessibility checks.

Manual and Automated Checks



Ensuring Accessibility

Manual and Automated Checks - 2

1. Content headings

2. Table attributes or 
merged cells

3. Alt text for images

4. Reading order

5. Color Contrast

6. Text size and spacing

7. Transcripts and closed 
captioning

8. Flashes and animations

9. Hyperlink text and 
provide the purpose of 
the linked text
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Ensuring Accessibility

Ensuring Accessibility – Step 1

Complete 
manual
accessibility 
checks.
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Ensuring Accessibility

Manual Checks

Content headings 
[content boxes and 
slide titles]*

Table attributes or 
merged cells*

Reading order*

Color Contrast*

Text size and spacing

Transcripts and closed 
captioning

Flashes and animations

Hyperlink text and 
provide the purpose of 
the linked text
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Ensuring Accessibility

Manual Checks (1)

Content headings

Content boxes

❑ Use built-in slide layouts with 
content boxes to ensure 
branding and accessibility.

❑ Avoid manually adding text 
boxes. 
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Ensuring Accessibility

Content Boxes
PowerPoint

Slides are designed with pre-
styled content boxes.

MDE Word and PowerPoint 
Templates (2026)
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Ensuring Accessibility

Manual Checks (1.1)

Content headings

Slide titles

❑ Ensure each slide has a unique 
slide title that is descriptive 
and directly relates to the 
content on the slide.
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Ensuring Accessibility

Manual Checks (1.2)

Content headings

Slide titles

❑ View slide in outline view to 
confirm slide titles. 

▪ View > Outline View

▪ Slide titles will appear as 
bold text in the outline.

▪ View > Normal to return to 
normal view.
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Ensuring Accessibility

Outline view
View > Outline

Slide number

Slide title

Missing slide title

Slide content



Ensuring Accessibility

Manual Checks (1.3)

Content headings

Slide titles

❑ Add missing slide titles or 
create hidden titles. Repeat for 
each slide.

▪ Tools > Check 
Accessibility

▪ In the Accessibility ribbon, 
click the down arrow 
beside Slide Title

▪ Add Slide title or Add 
Hidden Slide Title
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Ensuring Accessibility

Manual Checks (1.4)

Content headings

Slide titles

❑ Add missing slide titles or 
create hidden titles.

▪ Hidden titles will NOT
appear on the slide but 
will be read by the 
screen reader.
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Questions?

Question Break 1
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Ensuring Accessibility

Manual Checks (2)

Table attributes or merged cells

❑ Use simple table structures 
(no merged or blank cells).

❑ Identify column and row 
headers clearly.

❑ Use the Header Row option and 
repeat headers on each page.

❑ Use table styles in available 
MDE Templates.
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Ensuring Accessibility

Table Styles

A variety of table styles 
are available in the new 
document and slide deck 
templates.

MDE PowerPoint 
Templates (2026)

https://mdek12.org/communications/logos/


Ensuring Accessibility

Manual Checks (3)

Reading order

Objects are read in the order they 
are placed on the slide.

❑ Identify reading order in the 
reading order pane.

▪ In the Accessibility ribbon, 
click Reading Order Pane.
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Ensuring Accessibility

Manual Checks (3.1)

Reading order

Objects are read in the order they 
are placed on the slide.

❑ Identify reading order for each 
slide in the reading order pane. 

▪ In the Accessibility ribbon, 
click Reading Order Pane.
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Ensuring Accessibility

Reading Order Pane
• Checked items will be read aloud 

by the screen reader in the order 
they appear in the pane.

• Slide titles should always appear 
first in the reading pane, and the 
slide number should appear last.

• Warning symbols indicate 
graphics or images with missing 
alt text. Click the pencil to edit 
the alt text or mark the image 
as decorative.

• Click on the content name to 
select it. Click and drag the 
content to a different order or 
use the move buttons.

• Repeat for each slide.

Included content

Slide title
Edit alt text

Missing slide title



Questions?

Question Break 2
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Ensuring Accessibility

Manual Checks (4.1)

Color Contrast

❑ If the text color or background 
color deviate from the standard 
black and white, check the 
color contrast using a color 
contrast checker. 
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https://coolors.co/contrast-checker/00205c-ffffff


Ensuring Accessibility

Color Contrast Checker 
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Ensuring Accessibility

Color Contrast Checker (1.1)
Coolors.co free contrast checker
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https://coolors.co/contrast-checker/00205c-ffffff


Ensuring Accessibility

Approved Colors

Use MDE Brand 
Guidelines to find the 
Hex Codes of approved 
colors.
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Ensuring Accessibility

Color Contrast Checker (1.2)
Coolors.co free contrast checker
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https://coolors.co/contrast-checker/00205c-ffffff


Ensuring Accessibility

Add Approved Colors

Click on the Font Color or 
Fill Color menus. 

• Click “More Colors”.

• Type the Hex Code.
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Ensuring Accessibility

Accessibility Resources 
(Color)
Customer Support & Training webpage

• Resource for understanding 
color contrast checkers

https://mdek12.org/otss/cst/


Ensuring Accessibility  - Meaning

Meaning cannot only 
be communicated 
visually. 
Images. Colors. Fonts.
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Ensuring Accessibility

Manual Checks (4.2)

Color Contrast

Avoid using only color to convey 
meaning.

❑ Inspect each slide without color.

▪ In the Accessibility ribbon, 
click Inspect without color.
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Ensuring Accessibility

Inspect Without Color
Shows your slide in grayscale to 
help identify areas where color alone 
was used to convey information or if 
color combinations are difficult to 
perceive.

• When color only is used to 
convey information, add 
additional labels (text).

• Avoid color combinations such as 
red and green that can be 
difficult for people who are color 
blind to distinguish. 

• If the text is difficult to read when 
viewed in grayscale, it has low 
contrast with the background and 
needs to be adjusted.

• Repeat for each slide.

Slide without Color



Questions - 2

Questions?
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Ensuring Accessibility

Manual Checks (5)

Text Size and spacing

❑ Use MDE Template when possible 
as text size and spacing are 
defaulted in the content boxes.

❑ Slides: Text no smaller than 24 pts, 
line spacing no smaller than 1.0.
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Ensuring Accessibility

Manual Checks (6)

Transcripts and closed 
captioning

❑ Send videos to mdenet@mdek12.org
to be posted to to MDE’s YouTube

❑ Closed Captions will be 
autogenerated

❑ Review captions for accuracy

❑ Ensure captions are 
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Ensuring Accessibility

Manual Checks (7)

Flashes and animations

❑ Limit animations and movement 
to avoid distractions.
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Ensuring Accessibility

Manual Checks (8)

Hyperlink text and provide the 
purpose of the linked text

❑ If the resource will be accessed 
digitally (someone will click a link to 
access the webpage), avoid listing 
the URL.

❑ Add descriptive link text to URLs.

❑ Avoid linking directly to a PDF 
within another document. Instead, 
link to the website or landing page 
where that file is located. 
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Question Break 3

Questions?
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Ensuring Accessibility

Ensuring Accessibility – Step 2

Complete 
automated
accessibility 
checks.
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Ensuring Accessibility

Automated Checks

Alt text for images

Color Contrast*

Table attributes or 
merged cells*

Content headings* 
[content boxes and 
slide titles]

Reading order*

*Perform manual checks to verify automated checks
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Ensuring Accessibility

Accessibility Checker

▪ Tools > Check Accessibility

▪ In the Accessibility ribbon, click 
Check Accessibility
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Ensuring Accessibility

Accessibility Assistant
The Accessibility Assistant panel 
will open on the right side of 
your screen and checks the 
following categories:
• Color and Contrast – identifies hard-

to-read text contrast.

• Media and Illustrations – identifies 
missing alt text and missing audio or 
video subtitles.

• Tables – identifies missing table 
headers and use of merged/split cells.

• Document Structure – identifies 
missing and duplicate slide titles, 
default and duplicate section names, 
and prompts you to check reading 
order on slides.

• Document Access – identifies if 
content is restricted.

Check one slide at a time

No issues detected

Issues detected

Click on arrow to correct issues



Ensuring Accessibility

Automated Checks (1)

Color Contrast

❑ If the text color or background 
color deviate from the standard 
black and white, check the color 
contrast using a color contrast 
checker. 

❑ Click on the arrow beside the 
category to correct the issues 
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Ensuring Accessibility

Hard-to-read text contrast
• Select the content color to 

change (the object with 
hard-to-read contrast will be 
selected on the slide in the 
slide window).

Select the content 
color to change
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Ensuring Accessibility

Hard-to-read text contrast (1)
• Choose from filtered high 

contrast color options.

• Alternatively, you can 
manually enter the desired 
hex code in the fill color 
menu. 

Use the left arrow at the top to 
return to the Accessibility 
Assistant screen.

Choose from high 
contrast colors or 
manually change the 
color by entering the 
Hex code



Ensuring Accessibility

Automated Checks (2)

Alt text

❑ Ensure all images, charts, and 
graphs have alt text that can be 
read aloud by screen readers.

❑ Carefully write alt text to convey 
the images’ purpose.

❑ If the image does not convey 
important information or have a 
functional purpose, mark it as 
decorative.

Alt text: A screenshot of the MSIS Home screen. The user’s name 
will be displayed at the top of the page. 
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Ensuring Accessibility

Accessibility Resource 
(Alt Text)
Customer Support & Training webpage

• Instructions on how to 
write alt text

https://mdek12.org/otss/cst/


Ensuring Accessibility

Automated Checks (2.1)

Alt text

❑ Click on the arrow beside the 
category to correct the issues 
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Ensuring Accessibility

Missing Alt Text
• Enter desired alt text and 

click Save.

• Mark as decorative if the 
screen reader should skip 
over the image.

• Use the arrows at the top of 
the pane to navigate 
between images.

Use the left arrow at the top to 
return to the Accessibility 
Assistant screen.

Enter desired alt text

Mark as decorative

Save alt text

Use arrows to navigate 
to the next image



Ensuring Accessibility

Automated Checks (4)

Table attributes or merged cells

❑ Use simple table structures 
(no merged or blank cells).

❑ Identify column and row 
headers clearly.

❑ Use the Header Row option and 
repeat headers on each page.

❑ Use table styles in available 
MDE Templates.
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Ensuring Accessibility

Automated Checks (5)

Content headings

Slide titles

❑ Ensure each slide has a unique
slide title that is descriptive 
and directly relates to the 
content on the slide.
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Ensuring Accessibility

Missing Slide Title
• Choose from one of the 

provided options to fix the 
missing title. 

• Use the arrows at the top of 
the pane to navigate 
between slides.

Use the left arrow at the top to 
return to the Accessibility 
Assistant screen.

Set selected text box as 
the slide title

Add a new text box as 
the slide title

Add a hidden slide title

Use arrows to navigate 
to the next missing title
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Ensuring Accessibility

Unique Slide Title
• Edit the existing slide to a 

unique descriptor. 
Ex: Manual Checks (2)

• Use the arrows at the top of 
the pane to navigate 
between slides.

Use the left arrow at the top to 
return to the Accessibility 
Assistant screen.

Edit text box designated 
as the slide title

Use arrows to navigate 
to the next image



Ensuring Accessibility

Automated Checks (6)

Reading Order

Objects are read in the order 
they are placed on the slide.

Slides that have not been 
manually ordered in the 
reading order pane will appear 
in the automated checklist. 
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Ensuring Accessibility

Reading Order Pane (2)
• Checked items will be read aloud 

by the screen reader in the order 
they appear in the pane.

• Slide titles should always appear 
first in the reading pane, and the 
slide number should appear last.

• Warning symbols indicate 
graphics or images with missing 
alt text. Click the pencil to edit 
the alt text or mark the image 
as decorative.

• Click on the content name to 
select it. Click and drag the 
content to a different order or 
use the move buttons.

• Repeat for each slide.

Included content

Slide title
Edit alt text

Missing slide title



Ensuring Accessibility

PDF Compliance

• Slide decks should be checked 
compliance using built-in 
accessibility checks within PPT.

• If slides are saved as PDFs to 
be distributed electronically, the 
PDF should be checked for 
compliance again using built-in 
accessibility checks within 
Acrobat.
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Ensuring Accessibility

Save as a PDF

▪ File > Export

▪ File Format: PDF

▪ Best for electronic 
distribution and 
accessibility
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Ensuring Accessibility

Accessibility Resource 
(Adobe Acrobat)
Customer Support & Training webpage

• Checklists & Instructions for 
performing accessibility 
checks

https://mdek12.org/otss/cst/


Question Break 4

Questions?
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What is your role in digital 
accessibility compliance?
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Roles & Responsibilities

Digital Accessibility Compliance (ADA Title II)

Any NEW digitally-accessed 
documents, media, or posts
must be compliant by April 24.

Slide decks

Documents or other media 
posted to the MDE website
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Roles & Responsibilities

Compliance Exceptions

1. Archived web content, including content not currently used.

2. Pre-existing conventional electronic documents, unless such 
documents are currently used to apply for, gain access to, or 
participate in the public entity’s services, programs, or activities. 

3. Content posted by a third party, unless the third party is posting due 
to contractual, licensing, or other arrangements with the Title II entity.

4. Conventional electronic documents that are about a specific 
individual, their property, or their account and that are password-
protected or otherwise secured.

5. Social media posts that are made by a Title II entity before the date 
the entity must comply with this rule.

28 CFR 35.201



Roles & Responsibilities

Roles & Responsibilities

MDE
Employees

• Participate in Accessibility 
training based on your role 
(Basic and/or Advanced).

• Ensure accessibility 
compliance of digital 
resources before emailing, 
posting, or sharing.

• Email mdenet@mdek12.org
with any issues when 
attempting to ensure 
accessibility compliance.

Office of Technology & 
Strategic Services

• Provide Accessibility 
training.

• Post recording, slide deck, 
and other resources on the 
Customer Support and 
Training webpage.

• Provide assistance to any 
tickets received at 
mdenet@mdek12.org. 

Office of Communication & 
Government Relations

• Review any digital 
resources before posting 
them to EdUpdate, the MDE 
website, or social media. 
Resources that are out of 
compliance will be returned 
to the requestor to correct.

• Upload videos to YouTube 
and ensure close captions 
are generated.
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Resources

mdek12.org/otss/cst/

MDE – Digital Accessibility Resources

• Introduction to Digital Accessibility (Slide deck and recording)

72

https://mdek12.org/otss/cst/
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Roles & Responsibilities

Accessibility Resources
Customer Support & Training webpage

• Slide deck and recording

• Checklists & Instructions for 
performing accessibility 
checks

• Resources for understanding 
color contrast and alt text

https://mdek12.org/otss/cst/


Questions?
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Feedback

Let us know 
how we did!

forms.office.com/r/2ZQAFLxKzT
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Advanced Accessibility: 
PowerPoint
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